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	FLDigi	Con*iguration	Check	List	for	KI7PRK

Version	1.0,	Jan	4,	2018,	Chuckanut	Fire	ACS	

Overview:	This	document	introduces	an	initial	“standard”	conBiguration	of	the	
FLDigi	software	suite	including	FLDigi,	FLMsg,	FLAmp	and	other	modules	that	are	
useful	for	Em	Comm	situations.			This	document	discusses	a	basic	conBiguration	for	
FLDigi	and	FLMsg	message	operation	over	VHF	(2	meter/30-300	MHz)	or	UHF	
(70cm/300-3000	MHz)	FM	simplex	frequencies1	using	acoustic	coupling	or	wired	
coupling	(i.e.	Signalink	USB)	between	the	computer	and	the	radio.	We	will	use	FSQ	
4.5	at	145.580	MHz	for	general	texting	and	MT63-2000L	at	147.580	MHz	for	sending	
CERT	IC	forms2.	

Software	Version	and	Source:	This	document	assumes	FLDigi	3.21.76	or	later	
and	FLMsg	2.1.32	or	later	and	should	agree	with	the	Whatcom	County	EOC	version.		
The	FLDigi	software	suite	versions	change	rapidly	and	the	FLDigi	and	FLMsg	
versions	can	be	downloaded	from	the	website:	www.w1hkj.com	.	The	FLDigi	
software	manual	rig	control	is	assumed	here.	

Customization.	It	is	helpful	to	use	a	“standard”	conBiguration	in	Em	Comm	
situations	in	case	there	is	a	need	for	more	than	one	radio	operator	to	use	the	same	
computer.		Use	the	default	conBiguration	values	unless	speciBically	directed	to	do	
otherwise.		Many	sub-tab	conBiguration	panel	settings	in	FLDigi	(or	FLMsg)	are	left	
here	at	their	default	values	since	they	are	specialized	and	not	normally	used	for	2-
meter	Em	Comm	situations.	You	could	change	them	as	needed	but	you	should	leave	
the	radio	and	FLDigi	in	the	standard	conBiguration	before	you	leave	the	radio.

http://www.w1hkj.com
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FLDigi	Standard	Con*iguration	Check	List	

Open	FLDigi	and	Bind	the	ConBigure	menu.	When	any	changes	have	been	made	click	
the	“Save”	button	and	select	the	“ConBigure>Save	ConBig”	menu	selection.	Open	and	
set	settings	on	the	sub-	tab	panels	as	follows:	

ConBigure	>	Operator:	(Your	Call	SIgn)
Callsign:	<KI7PRK>
Name:	<Chuckanut	Fire	ACS>
QTH:	<Bellingham,	WA>	
Locator:	<CN88sp>
Antenna:	<Blackbird	144-450MHz	J-Pole>

[To	be	legal	the	operator	callsign	must	be	changed	here	each	time	the	radio	operator	that	uses	this	
computer	program	for	radio	transmissions	is	changed.]	

ConBigure>UI>Browser:	Use	default	values.	
ConBigure>UI>Contest:	Use	default	values.	
ConBigure>UI>General:	Use	default	values.	
ConBigure>UI>Logging:	Use	default	values.	
ConBigure>UI>Macros:	

Number	and	position	of	macro	bars:	Select	“Two	Bars	(Scheme	2)”.	[Using	two	
bars	allows	more	macros	for	keyboard-to-keyboard	operation.	See	the	
section	below	on	editing	macros.]

Check	(enable):	Load	last	used	macros	on	startup.
Check:	Display	macro	Bile	name	on	startup.	[optional]
Check:	Prompt	to	save	macro	Bile	when	closing.	May	be	disabled	later.	
ConBigure>UI>WF	Ctrls:	Use	default	values	(all	enabled).	Click	“Enable	all”	if	

not	enabled.	
ConBigure>UI>”Colors/Fonts”:	Use	default	values	for	all	submenues.	Can	

change	later.	

ConBigure>Waterfall>Display:	
Use	default	color	scheme.	
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Bandwidth	color	enabled.	
Center	line	color	enabled.	 
Signal	tracks	color	enabled.
Frequency	Scale:	Check	(enable):	Always	show	audio	frequencies.	
Transmit	signal:	Check	(enable):	Monitor	transmitted	signal.	
Signal	level:	Set	to	approximately	0.05	at	Birst.		Adjust	as	needed	for	clarity.	

ConBigure>Waterfall>FFT	Processing:
Use	default	values	which	are	usually:	

Lower	Limit:	0
Upper	Limit:	3000
FTT	Latency	(scan	merging):	4
Unchecked	(disabled):	FFT	Averaging	
FFT	preBilter	function:	Blackman.

Waterfall	height	in	pixels:	125	(default	value).
[Note:	This	could	be	changed	to	Bit	to	the	computer	screen	
better.]	

ConBigure>Waterfall>Mouse:
Check	(enable):	Left	or	right	click	always	replays	audio	history.	
Uncheck	(disable):	Dragging	on	the	waterfall	scale	changes	frequency.
Check	(enable):	Insert	text	on	single	left	click.	“<FREQ>”	
Wheel	Action:	Modem	carrier	(default	value).	

ConBigure>Modems>CW:	Use	default	values	for	all	submenues.	
ConBigure>Modems>Dom:	Use	default	values.	Secondary	text:	<your	callsign>	
ConBigure>Modems>Feld:	Use	default	values.
ConBigure>Modems>MT-63:	

You	should	intially	use	the	“long	interleave	mode”	selection:	

Use	the	main	menu	selection	“Op	Mode>MT63>MT63-2000L”.4	

Check	(enable):	8-bit	extended	characters	(UTF-8)	
Uncheck	(disable):	Long	receive	integration.	
Check	(enable):	Lower	start	tone
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Check	(enable):	Upper	start	tone
Tone	duration:	2	seconds,	[the	default	value	of	4	is	OK	also]
Uncheck	(disable):	Allow	manual	tuning.5	[For	MT63-2000,	VHF-UHF]	

[This	may	be	enabled	for	other,	narrow	modes	for	Blexibility.]	
ConBigure>Modems>Olivia:	Use	default	values	(e.g.,	500	bandwidth,	8	tones,	UTF-8)	

[Olivia	is	used	extensively	in	HF	transmissions.]	
ConBigure>Modems>Cont’:	Olivia	conBiguration	continued.	Use	default	values.	
ConBigure>Modems>PSK:	Use	default	values
ConBigure>Modems>RTTY:	Use	default	values.
ConBigure>Modems>Thor:	Use	default	values.	

Secondary	txt:	“Bldigi-thor	<callsign>”	
ConBigure>Modems>Navtex:	Use	default	values.	
ConBigure>Modems>Wefax:	Use	default	values.	

ConBigure>Rig>Hardware	PTT:	Disable.	[Check	boxes	unchecked.]	
ConBigure>Rig>RigCat:	Disable.
ConBigure>Rig>HamLib:	Disable
ConBigure>Rig>MemMap:	Disable	
ConBigure>Rig>XML-RPC:

Check	(enable):	Use	XML-RPC	program.	
Click	on	“Initialize”	button.	Click	on	Save	button.	

ConBigure>Audio>Devices:
Check	(enable):	PortAudio.	
If	you	will	be	using	acoustic	coupling	(not	likely):6	

Select	Capture:	Primary	sound	capture	device	(i.e.,	internal	microphone)	
Select	Playback:	Operating	system	sound	output	(i.e.,	speakers)	

Else	if	you	will	be	using	a	Signalink	USB	box	to	wire	computer	to	radio:7	

Select	Capture:	USB	Audio	CODEC
Select	Playback:	USB	Audio	CODEC
[See	also	section	on	use	of	Signalink	USB.]	

Uncheck	(disable):	File	i/o	only.	

[NOTE:	If	you	switch	between	acoustic	coupling	and	wired	coupling	you	
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must	change	the	above	selection	choices	accordingly.]8	

ConBigure>Audio>Settings:	Use	defaults	
ConBigure>Audio>”Right	channel”:	Use	defaults	
ConBigure>Audio>Wav:	Use	defaults	

ConBigure>ID>RsID:	Use	default	values.	
ConBigure>ID>Video:	Use	default	values.	
ConBigure>ID>CW:	Use	default	values.	

ConBigure>Misc>CPU:	Use	default	value	(unchecked)	unless	CPU	is	slow.	
ConBigure>Misc>NBEMS:	

Check	(enable):	NBEMS	data	Bile	interface
Uncheck	(disable):	Open	message	folder.	[Enable	only	when	needed.]	
Check	(enable):	Open	with	Blmsg.
Check	(enable):	Open	in	browser.
Browse	and	select	the	folder	containing	the	FLMsg	application.	

The	FLMsg	application	folder	label	contains	the	version	number.	
Time	out:	2	seconds	(default	value).	

ConBigure>Misc>PSKMail:	Use	default	values.	
ConBigure>Misc>Spotting:	Use	default	values.	
ConBigure>Misc>Sweet	Spot:	

Set	“PSK	et	al.”	to	1500	(default).	This	is	the	audio	frequency	used	
automatically	for	the	center	frequency	on	the	waterfall	for	MT63-2000	
when	the	“Allow	manual	tuning”	conBiguration	in	the	“ConBigure-	
Modems>MT63”	panel	is	unchecked	(disabled).	

ConBigure>Misc>Text	i/o:	
Check	(enable):	Enable	rx	text	stream.	
Ignore	the	“Talker	Socket”	setting	(default	value	is	disabled).	

ConBigure>Misc>DTMF:	
Uncheck	(disable):	Decode	DTMF	tones.	

ConBigure>Misc>WX:	Use	default	values.	
ConBigure>Misc>KML:	Use	default	values	

ConBigure>Web>Call	Look-up:	Use	default	values	(No	database,	no	look-up.]	
ConBigure>Web>eQSL:	Use	default	values.	
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FINALLY:	Click	the	SAVE	button,	the	Close	button.	And	Select	
the	“ConTigure>Save	ConTig.”	Menu	selection.	

Other	FLDigi	Con*iguration	Settings	

Logging.	To	save	the	receive	Bile	the	“File>Text	Capture>Log	all	rx/tx	text”	must	be	
checked	(enabled).	You	will	need	to	do	this	for	Em	Comm	situations	in	order	to	keep	
a	time-stamped	record	of	everything	for	the	purpose	of	reconstructing	events	and	for	
legal	purposes.	The	“served	agency”	may	require	you	to	produce	this	Bile	as	legal	
evidence.	Once	checked,	select	the	“ConBigure>Save	ConBig.”	Menu	selection	to	make	
it	permanent.	(After	a	real	emergency	Em	Comm	event	this	rx/tx	Bile	should	be	saved	
permanently	in	a	safe	storage	location.)	

Operation	Mode:	Select	“Op	Mode>MT63>MT63-2000L”.	Exiting	the	program	will	
save	the	“Op	Mode”	conBiguration.	

“Call”	Tield:	If	you	enter	a	callsign	in	the	“Call”	Bield	it	will	be	used	by	macros	that	
use	the	<CALL>	macro.	Your	own	callsign	must	be	used	when	the	<MYCALL>	macro	
is	used.	The	<MYCALL>	value	should	be	replaced	by	the	callsign	of	the	current	
operator	in	the	“ConBigure>OP”	conBiguration	panel	for	transmissions	to	be	legal.	

Squelch	settings:	At	the	bottom	right	of	the	FLDigi	window	is	a	“SQL”	button.	It	
should	be	clicked	to	enable	squelch	control	(button	indicator	should	be	yellow).	The	
vertical	control	bar	at	the	bottom-right	side	of	the	window	is	the	squelch	control	and	
it	should	be	adjusted	so	that	“random	characters”	generation	stops	but	the	digital	
signal	streams	(green	vertical	bar	indicator)	break	squelch	(is	higher	than	the	
squelch	control	handle	value)	and	the	print	in	the	receive	Bield	is	clear	and	without	
extraneous	characters.	

Signalink	USB	Settings:	We	use	a	wired	connection	between	the	computer	and	
the	radio	you	reduce	the	possibility	of	introducing	noise	in	your	environment	or	
picking	up	unwanted	environmental	noise.	This	is	important	in		Incident	Command	
Center	situations.	(You	may	need	to	use	a	headset	if	you	need	to	hear	the	
transmission	activity.)	The	three	manual	dials	on	the	Signalink	should	be	set	initially	
to	the	following:	TX	at	8’oclock	(nearly	fully	counter-clockwise),	RX	at	50%,	DLY	at	8	
o’clock	(nearly	fully	counter-clock	wise).	Radio	operations	using	the	FLMsg	and	
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keyboard-to-keyboard	messaging	can	be	totally	silent	and	can	be	done	on	the	same	
(digital,	simplex)	frequency.	[A	second,	voice	frequency	for	message	coordination	is	
not	really	needed	but	may	be	useful	when	learning	the	technique.]	The	RX	dial	value	
on	the	Signalink	USB	device	can	be	adjusted	so	that	the	waterfall	signal	is	clear	and	
mostly	blue	&	white.	It	should	not	be	red	color,	but	a	small	amount	of	yellow	color	is	
ok.	[SPECIAL	NOTE:	The	Singnalink	USB	device	uses	isolator	circuits	to	keep	RF	and	
computer	electrical	noise	controlled.	Other	custom	wiring	techniques	may	have	to	
use	special	RF	isolation	techniques	and	level	adjustors	to	optimize	the	signal	on	the	
waterfall.]	

Computer	Volume	Settings:	When	using	the	Signalink	USB	device	the	Volume	
setting	in	the	computer	should	be	set	to	maximum	(100%).	(SPECIAL	NOTE:	Check	
this	each	time	you	start	a	session	if	using	a	Windows	operating	system	since	the	
Windows	OS	update	program	always	resets	the	volume	to	50%.	You	must	set	it	back	
to	100%	for	the	Signalink	USB	to	cause	transmittion	to	occur.	(The	red	light	turns	ON	
when	the	PTT	function	is	active.)	Or,	disable	the	Windows	Update	program	so	the	
volume	setting	is	never	changed.)	When	using	acoustic	coupling	(very	unlikely)	a	
speaker	volume	setting	near	50%	and	a	normal	internal	microphone	input	sensitivity	
setting	should	work.	Test	and	adjust	as	needed.	

Frequency	Settings:	The	frequency	set	into	the	radio	should	be	chosen	from	the	
VHF	(or	UHF)	band	plan	from	the	designated	digital	frequencies	(for	example,	f=	
146.580).	Monitor	the	frequency	to	determine	if	it	is	used.	VHF	FM	simplex	
frequencies	should	be	used	since	repeaters	have	transmission-time	limits	and	the	
repeater	owner	may	not	allow	digital	trafBic.	The	frequency	used	can	be	entered	into	
the	frequency	Bield	near	the	top	of	the	FLDigi	window.	It	does	not	otherwise	affect	
operations.	

RXID,	TXID	and	Tune	Buttons:	These	buttons	should	normally	all	be	OFF	(unlit)	
for	VHF	digital	messaging	with	the	MT63-2000L	mode.	[TXID	is	sometimes	set	ON	
when	using	HF	frequencies	and	other	modes.]	

Use	of	Default	Macros:	The	Birst	(lower)	row	of	default	macros	can	be	used	when	
they	are	useful.	Remember	that	you	must	be	sure	that	transmission	is	turned	off	
after	each	message.	You	can	open	the	macro	editor	to	see	just	how	they	are	coded.	
This	can	be	done	with	some	of	the	blue	macros	or	by	clicking	the	“T/R”	button	at	the	
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right	end	of	the	second	line	from	the	bottom	of	the	window.	

FLMsg	Con*iguration	and	Operation	

The	following	are	the	settings	for	FLMsg	conBiguration	which	should	be	used	initially	
for	local	(county-wide	and	state-wide)	messaging.	

Call	Sign:	Select	the	“ConBig>Personal	Data”	menu	selection	to	open	up	the	panel	
where	you	MUST	enter	your	call	sign.	Enter	related	personal	data	also	(such	as	your	
mobile	phone	 number).	The	call	sign	is	used	to	form	the	message	Bile	names.	The	call	
sign	entry	should	be	changed	every	time	the	radio	operator	changes.	

Date-Time:	Select	the	“ConBig>Date/Time”	panel	and	conBirm	the	default	setting	
are	selected	(YYYY-MM-DDj,	hhmmL,	The	“L”	means	local	time.]	[Zulu	time	is	used	
when	communicating	across	time	zones.]	

Files/Formatting:	Select	the	“ConBig>Files/Formating”	panel.	The	“open	folder	
when	exporting”	option	should	be	disabled	initially.	Enable	all	checkboxes	in	the	
“Naming	Files”	section	of	the	panel	(Call-sign,	date/time,	serial	number	all	enabled).	
The	serial	number	value	can	be	reset	to	“1”	at	the	beginning	of	each	day,	if	needed.	
Ignore	the	MARS	roster	Bile	setting.	Enable	word	wrap	at	72	characters	per	line.	

Radiogram:	Select	the	“ConBig>Radiogram”	panel.	Use	the	default	values	(5	
message	words	per	line,	auto-increment	enabled,	“show	ARL	descr’”	enabled.)	

Socket	I/O:	Select	the	“ConBig>Socket	I/O”	panel.	Use	the	default	values.	

Header	Trace:	Select	the	“Help>Header	Trace”	panel.	Become	familiar	the	position	
and	contents	of	the	“From”	and	“Edit”	Bields.	These	are	blank	until	a	message	Bile	is	
edited	or	sent	(using	the	“AutoSend”	button	in	the	menu	bar.)	Do	nothing.	

Form	Usage:	Read	the	documentation	from	the	software	website	to	learn	about	
the	menu	options	and	types	of	forms.	For	initial	practice	at	hospitals	select	
“Form>HICS>HICS213”	form	entry	mode.	(Hospitals	and	medical	institutions	in	
California	train	on	using	HICS	forms	while	county	Fire,	Law	and	county	agencies	
usually	use	ICS	forms.]	Enter	examples	into	the	Bields.	Use	the	“File>Save”	menu	
selection	to	save	the	Bile.	Hint:	As	you	do	so	you	will	discover	that	it	is	helpful	to	
append	a	few	characters	at	the	end	of	the	Tile	name	to	indicate	the	location	the	
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message	is	being	sent	to.	This	makes	it	easier	to	Bind	when	trying	to	open	it.	To	
reopen	a	message	you	normally	Birst	select	the	type	from	the	“Form”	menu	before	
using	the	“File>Open...”Menu	selection.	When	the	form	is	Tilled	out	completely	it	is	
transmitted	by	clicking	on	the	“AutoSend”	button.	This	automatically	saves	the	
form	with	its	contents	and	appropriate	changes	in	the	“Help>Header	Trace”	edit	
Bield.	The	message	is	then	automatically	transmitted.	To	retransmit	a	closed	Tile	
merely	open	it	and	click	“AutoSend”.	All	of	the	CERT	IC	Forms	should	be	in	the	
macro	list.		Explore	other	form	types	for	use	for	spread-sheet	data,	etc..	The	
“Template”	menu	allows	one	to	make	custom	forms	or	sub-Bields	in	standard	forms	
Print	messages	from	the	browser	(html	delivery)	form	that	pops	us	when	received.	

Custom	Macros	for	Em	Comm	Situations	

Aa	few	custom	macros	for	Em	Comm	can	be	used	when	doing	“keyboard-to-	
keyboard”	transmissions.	[Some	call	keyboard-to-keyboard	transmissions	a	“chat”	
mode.]	Using	these	macros	makes	keyboard-to-keyboard	responses	quick	and	
accurate.	In	addition,	keyboard	macros	can	be	initiated	easily	by	a	click	of	the	mouse	
and	are	therefore	very	useful	during	remote	operations	when	you	may	not	have	
direct	access	to	the	keyboard.9	

Select	a	Row	of	Macro	Buttons:	A	left-click	on	the	far-right	button	(initially	
showing	the	row	number	“2”)	of	the	upper	macro	button	row	will	change	the	upper	
row	to	another	row.	The	row	number	that	is	visible	will	change.	A	right-click	
decreases	the	row	number	and	reveals	the	corresponding	row	of	macro	buttons.	
When	Birst	set	to	“Two	button	rows	(Scheme	2)”	you	may	see	a	row	of	macros	used	
for	contesting.	You	can	move	these	to	row	3	or	just	put	a	new	row	of	Em	Comm	
macros	in	row	3.	For	now,	put	them	in	row	3.	[The	row	number	has	to	be	selected	
every	time	you	open	FLDigi.	It	is	not	saved	in	the	current	versions	of	FLDigi.].	
Alternatively,	move	the	default	row-2	entries	to	row-3	and	replace	the	original	row-2	
entries	with	new	ones.	

Macro	Color	Groups:	There	are	three	color	groups	of	four	buttons	(Blue,	
Magenta,	Dark	Blue)	from	left	to	right	in	each	button	row.	We	will	number	the	
buttons	from	1	through	12	here	with	the	leftmost	button	called	button	#1.	Group	
macros	together	that	make	sense.	Some	suggested	macros	for	Em	Comm	are	given	
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below	as	an	example.	

Editing	Macros:	To	edit	a	macro	right-click	on	a	macro	button	to	open	the	macro	
edit	panel.	Edit	the	label	to	assign	the	desired	label.	Edit	the	body	with	the	deBinition	
you	want	for	the	macro.	Hints:	Use	a	RETURN	keystroke	after	the	initial	<TX>	and	
before	the	Binal	<RX>	to	move	to	a	new	line	for	clarity.	For	the	<<	TCS>>	bracket	
substitute	the	“tactical	call	sign”	of	your	location,	e.g.,	“Sutter	Roseville”	is	the	tactical	
callsign	for	Sutter	Roseville	Medical	Center.	Alternatively,	leave	the	<<TCS>>	out	and	
rely	on	the	<MYCALL>	to	identify	your	station.	

Include	the	trailing	“.	.	.	de	<MYCALL>”	at	the	end	of	the	message	line	to	comply	with	
you	amature	license	rules.	A	RETURN	before	the	<RX>	moves	to	the	next	line	for	
clarity.	The	<CLRTX>	clears	the	TX	Bield	after	the	message	is	sent.	[As	the	message	is	
sent	it	is	recorded	in	the	RX	window	and	is	saved	in	a	permanent	Bile.	This	rx/tx	Bile	
should	be	saved	to	a	different,	permanent	location	after	the	drill	or	emergency	for	
legal	purposes.)	

Closing	the	Macro	Editor.	In	the	macro	editor	click	the	“Apply”	button	when	you	
are	Binished	editing	the	macro.	Then	click	the	“Close”	button.	Test	the	macro	by	
clicking	on	the	macro	button.	To	make	the	change	permanent	you	must	select	the	
“File>Macro>Save	Macros...”	menu	selection	and	save	the	macro	to	a	unique	Bile	
name	with	the	“.mdf”	extension.	Be	sure	that	the	“ConBigure>UI>Macro”	>	“Load	last	
used	macros”	checkbox	is	checked	(enabled).	Select	the	“ConTigure>Save	ConTig.”	
menu	selection	before	exiting	the	FLDigi	program.	

Our	macros:	

-----------------	Green	Macro	Button	Group	(leftmost	group)	-------------------	

Generally,	these	macros	are	useful	to	indicate	your	readiness	to	receive	
FLDigi	messages.	

Macro	#	1	(CQ	>|)
<TX>
CQ	CQ	CQ	de	<MYCALL>	<MYCALL>	<MYCALL>\n
CQ	CQ	CQ	de	<MYCALL>	<MYCALL>	<MYCALL>	pse	k\n
<RX>
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Macro	#	2	(ANS	>|)
<TX><CALL>	<CALL>	de	<MYCALL>	<MYCALL>	<MYCALL>	kn\n
<RX>

Macro	#	3	(QSO	>>)
<TX>\n
<CALL>	de	<MYCALL>	

Macro	#	4	(KN	||)
	btu	<NAME>	<CALL>	de	<MYCALL>	k\n
<RX>

Macro	#	13	(Ready)
<TX>\n
<<TCS>>	Monitoring	<DIGI>.	.	.	de	<MYCALL>	<RX><CLRTX>

Macro	#	14	(Data	Received)
<TX>\n
<<TCS>>	<DIGI>	data	received	.	.	.	.	de	<MYCALL>	<RX><CLRTX>

Macro	#	15	(Data	Not	Received)
<TX>\n
<<TCS>>		<DIGI>	did	not	receive	data	.	.	.	.	de	<MYCALL>	<RX><CLRTX>

Macro	#	16	(Pause)
<PAUSE>

-----------------	Magenta	Macro	Button	Group	(center	group)	----------------	

This	group	for	up	to	4	pre-determined	QSO’s	that	is	used	repeatedly.	Using	macros	
similar	to	these	macro	makes	keyboard-to-keyboard	responses	quick	and	accurate.

Macro	#	5	(Bye)
\n
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tnx	fer	QSO	<NAME>,	73\n
<ZDT>	<CALL>	de	<MYCALL>	sk\n
<RX>

Macro	#	6	(My	ID	/	Sq	Location)
\n
my	name	...	<MYNAME>\n
my	QTH	....	<MYQTH>\n
my	LOC	....	<MYLOC>\n

Macro	#	7	(My	Setup	info)
\n
<<	<MYCALL>,	<MYNAME>	>>\n
Rig:	Yaesu	FT-800	dual	band	VHF/SignaLink/Windows/FLDigi	\n
Pwr:	50	watt\n
Ant:	Blackbird	144-450	MHz	J-Pole	\n
OS:	Windows	7\n
Soft:		<VER>\n
Web:	http://roadrunner110.wixsite.com/chuckanutacs\n
Email:	roadrunner11@mac.com

Macro	#	8	(Clear	Text)
<CLRTX>

Macro	#	17	(C	Decr)
<DECR>

Macro	#	18	(Log	QSO)
<LOG><INCR>

Macro	#	19	(CW-CQ	>|)
<TX>CQ	CQ	CQ	DE	<MYCALL>	<MYCALL>	<MYCALL>		CQ	CQ	CQ	DE	<MYCALL>	

K<RX>
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Macro	#	20	(Net	Check-in)
<TX>\n
<<TCS>>	Chuckanut	Fire	ACS	net	check-in	<DIGI>	<CALL>	<LT[:fmt]>	.	.	.	.	de	

<MYCALL>	<RX><CLRTX>

-----------------	Dark	Blue	Macro	Button	Group	(rightmost	group)	----------	

The	following	macros	are	useful	to	indicate	speciBic	“handshake”	operations	needed	
to	acknowledge	correct	transmissions	or	disconBirm	them:	

Macro	#	9	(T/R)
<TX/RX>

Macro	#	10	(Tx)
<TX>

Macro	#	11	(Rx)
<RX>

Macro	#	12	(TX	KI7PRK)
<TX>\n
de	<MYCALL>	k\n
<RX>

Macro	#	21	(Get	Ready)
<TX>\n
TX	within	30	sec	.	.	.	de	<MYCALL>	<RX><CLRTX>

Macro	#	22	(Did	NOT	Copy)
<TX>\n
Please	repeat	.	.	.	de	<MYCALL>	kn	<RX><CLRTX>

Macro	#	23	(Good	Copy)
Copy	was	100%	at		db	<LT[:fmt]>.	.	.	de	<MYCALL>	<RX><CLRTX>
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Macro	#	24	(How	Copy?)
<TX>\n
...	How	Copy?	...	de	<MYCALL>	k	<RX><CLRTX>
Macro	9	(Dark	Blue):	Label	“TX	30s“.	Macro	deBinition:	
<TX>	
TX	within	30	sec	.	.	.	de	<MYCALL>	<RX><CLRTX>	

There	are	additional	macro	tags	that	can	be	of	use	and	a	total	of	48	macro	
buttons	available	in	the	software.		Extra	buttons	can	be	shown	in	the	
“View/Hide	48	Macros”	under	the	View	Menu.		Do	a	right-click	over	any	
button	to	get	to	the	edit	window.	A	list	of	all	available	macro	tags	in	the	
right-hand	scrolling	panel.	Consider	each	of	them	as	you	design	useful	
macros.	Design	macros	useful	for	all	team	members	and	with	their	
consensus.	

Other	FLDigi	Software	

Other	useful	software	modules	include	FLRig	for	rig	control	and	FLAmp	
for	transmission	with	intermediate	error	checking	of	short	segments	of	
long	messages	(photos).	

The	FLDigi	suite	was	created	in	Linux	and	was	cross-compiled	to	
Windows	and	Macintosh	operating	systems.	All	these	work	the	same	and	
are	maintained	simultaneously.	For	detailed	information	at	the	Yahoo	
groups:	NBEMSham,	Win-FLDigi,	Ham-Mac	or/and	LinuxHam	groups.	

FLRig.	Useful	if	the	radio	has	a	“CAT”	(control)	port	as	for	most	HF	rigs.	
This	allows	you	to	choose	frequencies,	bands	and	other	parameters.	Many	
radios	do	not	have	a	CAT	port,	such	as	several	mobile	radios.	There	may	
be	ways	to	use	custom	electronics	hardware	to	emulate	one	of	the	radios	
implemented	in	FLRig	and	other	rig	control	software	packages.	

FLAmp.	Useful	for	long	Bile	transfers	such	as	photos.	See	details	in	the	
manual.	
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FLLog.	Useful	for	logging	communications.	See	details	in	the	manual.	

FLNet.	Useful	for	administration	and	operation	of	nets.	See	details	in	the	
manual.	

See	the	manual	regarding	installing	and	operating	multiple	copies.	Each	
copy	may	be	used	with	a	different	radio.	

1	Check	in	with	the	Resource	Net	coordinator	to	determine	speciBic	frequencies	to	be	used	for	a	given	event.	Usually	we	
will	be	using	145.580	MHzfor	text.		Message	trafBic	will	use	2m	and	70cm	simplex	frequencies	for	direct-line-of-sight	
communications	and	when	repeaters	are	not	available.
2	There	are	some	newer	modes	implemented	in	FLDigi	that	are	useful	for	digital	communications	and	that	are	
signiBicantly	faster.	The	MT63-2000L	mode	is	a	default	mode	that	all	radio	operators	should	train	on	initially	for	VHF	
FM	communications.	It	has	been	shown	to	be	reliable	when	using	acoustic	coupling	methods.		This	mode	is	the	one	we	
use	for	FLMsg	for	sending	CERT	IC	Forms.

4	All	operators	MUST	use	the	same	choice	or	decoding	to	text	will	not	be	able	to	be	done.	Check	this	if	you	are	
having	decoding	troubles.	In	previous	versions	of	FLDigi	there	was	a	checkbox	for	“64-bit	(long)	interleave”.	Recent	
versions	(including	ours)	put	the	“long”	selection	as	part	of	the	“Op-Mode”	tab	selection	on	the	main	menu	of	FLDigi.	To	
use	the	“long”	interleave	with	MT63-	2000	select	the	following	from	the	main	menu:	“Op	Mode>MT63>MT63-2000L”.	
FYI,	the	“MT63-	2000S”	entry	means	“short”	interleave.	

5	If	all	operators	do	this	then	time	will	not	be	wasted	hunting	for	the	signal.	Using	this	setting	(i.e.,	“disabled”)	
means	that	the	center	frequency	for	MT63-2000	will	be	set	automatically	at	start-up	to	be	at	the	middle	of	the	waterfall	
panel.	See	the	section	on	“ConBigure>Misc>Sweet	Spot	“	below.	You	may	want	to	enable	it	for	narrower	modes	such	as	
PSK31	since	the	waterfall	may	show	several	PSK31	signals	that	you	will	want	to	choose	from.	

6	Acoustic	coupling	probably	takes	two	hands	to	hold	the	microphone	up	to	the	speakers.	This	means	that	you	do	not	
have	a	free	hand	to	write	down	messages,	control	your	rig	or	hold	onto	an	intercom	device.	You	cannot	do	acoustic	
coupling	for	remote	operations.

7	For	remote	operations	use	a	wired	conBiguration	with	a	Signalink	USB	device.	

8	While	you	should	be	comfortable	with	acoustic	coupling	there	are	several	reasons	that	you	probably	are	better	off	
using	a	Signalink	USB	wired	connection.

9	This	section	describes	only	one	added	row	of	macros.	Additional	rows	may	also	be	deBined,	as	needed,	and	such	
macros	will	often	be	found	useful	for	remote	operations.

(Modi*ied	from	Placer	County	CA	ARES	by	John	Hestenes	KJ6CVB)


